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“In March winter is 
holding back and 

spring is pulling for-
ward. Something holds 
and something pulls in-

side of us too.” 
― Jean Hersey  
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“Today is the day when bold kites fly, 
When cumulus clouds roar across the sky. 
When robins return, when children cheer, 
When light rain beckons spring to appear.” 
― Robert McCracken, Spring  

Northumberland Hills, Janet Taylor 
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Creating a Mirror Montage in Photoshop 

BY MOIRA FENNER 

Some time ago, I attended a workshop with Andre Gallant, a wonderful Canadian photographer.  I purchased 
his book “Inspiration” in which he shares a number of creative photography projects.  I thought you might 
enjoy trying your hand at creating some Mirror Montages.  Experimentation with different images is key, but 
it’s all about creating something you appreciate. 
 

1. Open the image you have selected in Photoshop.  Go to Image>Duplicate to make a copy of your image.  
To see both images on your desktop, go to Window>Arrange>Float in Window. 

2. With one image selected, go to Image>Image Rotation>Flip Canvas Horizontal.  You can play with the 
other options, but generally this one gives an interesting effect. 

3. Go to the Move tool (at the top of your Photoshop tool bar), click on the rotated image and drag on top of 
the other image. 

4. In the Layers panel on the right of your screen, choose the Multiply blending mode and the mirror mon-
tage will appear. 

5. Using the Move tool, click on the top photo and slide it left or right until you find a look you like.  

6. Crop your image and go to Layer on the top tool bar and Flatten Image. 

7. Make any final adjustments to exposure and save your file. 

 
 

 

Original Image  Mirror Montage  
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The Monitor  

TRAVEL PHOTOGRAPHY 
BY NORM RAE 

Since my wife and I retired almost 18 years ago, we have visited around 55 countries, sometimes as many as 
8 or more in a 10-week trip. In the last few years we have been a bit less adventurous. A favourite winter 
trip has been to visit the Canary Islands in the first part of February, then move up to mainland Spain or Por-
tugal, when the weather gets warmer. 

 

Lanzarote 

In early February 2020, we chose the island of Lanzarote for our first two weeks. We had previously ex-

plored Grand Canary Island, Tenerife and Fuerteventura.  We treated ourselves to an all-inclusive resort for 

a week, then moved to a self-catering bungalow.  

Sunset in front of our resort in Lanzarote.  
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Our bungalow view and local “pothead” humour  

We visited a large cactus garden and toured a cave where the reflection of the roof in very still water 
makes it look like a canyon.  
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     Javea                                       
After two weeks on Lanzarote we flew to Valencia on the mainland and drove 1-1/2 hours south in a rental 
car to the small coastal town of Javea. We rented a small house for a week, a ten-minute walk to a very nice 
beach area. The beautiful Mediterranean coastline was a spectacle of cliffs and beaches! The weather was 
cool first thing in the morning, but warmed to mid-20s by midday. We completed a different coastal walk 
each day, enjoyed exploring the small towns, and participating in the café culture. 



 6 

March 2021 

      Valencia 
 
After driving back to Valencia, we took the subway to the centre of the city.  We spent 3 nights in a hotel 
close to the cathedral and the major sights. We enjoyed the city ‘hustle and bustle’ after three weeks in small 
towns. 

      The cathedral area at night. The interior of cathedral, left, and bottom right, another church we visited. 
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One day, we took a bus to the beach area that was over a mile long. We walked around the harbour and then 
to the very modern buildings of the City of Arts and Sciences.  The first building was opened in 1998, and the 
last opened in 2009. The site was on an old river bed. The river had been redirected after major flooding. The 
City contains Europe's biggest aquarium, science museum, arts centres, opera house, Imax cinema, planetari-
um, and various open air art galleries and parks. 
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     Seville 
Next was a flight to Seville, where we rented a small apartment in the centre of town for a week. 

There are some spectacular buildings here. The Alcazar was similar to the Alhambra in Granada, with vari-
ous buildings, gardens and fountains, some dating from the 10th century. The Seville Cathedral, the world’s 
largest gothic church, opened in 1528 and contains the Tomb of Columbus. The 342-ft high Giralda Tower 
has a series of internal ramps instead of steps. These were supposedly built so that the sultan could ride to the 
top on his horse. The Cathedral/Alcazar was designated a World Heritage Site in 1987. 
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The interior of the cathedral including, bottom left, the tomb of Christopher Columbus.  
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We visited a few other sites in Seville, including the 
Hospital de los Venerables, a 17th century baroque style, 
former retirement home for priests. It has a very ornate 
church and an art gallery containing many works by Ve-
lasquez, among others. 
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The Plaza de Espana is a large semi-circular building with a man-made lake and a large park. It was built for 
the Iberian/American Expo of 1929.  On our walk there we saw a huge protest march, demonstrating against 
privatizing of schools. Just like Ontario, we thought! 

Flamenco dancers entertaining us as we strolled around the perimeter of the vast building.  
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Majorca 
 
We flew to the island of Majorca to complete our vacation. We picked up a rental car and drove to a beauti-
ful self-catering apartment on the 8th floor of a building in the small coastal town of Cala Millor, overlook-
ing a beach and the Mediterranean Sea. We toured the northern part of Majorca, visiting small towns and 
viewpoints on the coast as well as a wildlife wetland reserve. The reserve had blinds set up where one could 
watch and photograph the birds and the elusive wild horses. 
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Things get tougher 
We had English news channels on TV in our apartment, but we did not hear much about Spain. We were shocked when we got a mes-

sage from Air Canada to say they had cancelled our flight home from Madrid, and booked us on a flight home from Munich! No word on 

how we should get to Munich and no way to contact Air Canada. We did cancel our flight from Majorca to Madrid and booked a flight on 

Vueling (Spanish airline) to Munich. 

We had booked a week in a resort in the south of the island for our last week, about a 2-hour drive across the island. We stopped at a 

small town for a break and to look at the church. We were surprised that the church was closed, and also, when we saw people lining 

up outside a small store. Of course, this was Spain's first day of severe lockdown due to COVID. When we arrived at our resort, we dis-

covered there were only about 50 people staying there and that we had to stay on the hotel grounds. Later, we found a small grocery 

store just outside the resort gates where we could buy essentials, e.g. - beer and wine, and snacks. After staying one night, there was a 

note under our door saying that the resort was closing the next day, and that everyone would be transferred to a sister hotel near Pal-

ma, close to the airport. We drove to Palma, dropped off our rental car and were able to walk to our hotel.  

When we gassed up our rental car, we encountered Spain's strict lockdown rules. It was a self-serve station, but an attendant made 

sure we put on disposable gloves before touching anything, and payment was made via a small drawer that connected to the inside of 

the station. Of course, as in Canada, there were no thoughts of masks at that time.  

The hotel was adequate and quite busy the first night, with 90% of the guests German tourists. We were making the most of things, 

but, did get a note from Vueling to say our flight to Munich was cancelled. I think they had grounded all flights. We finally found a flight 

with Lufthansa to Frankfurt two days earlier than we had planned to leave, and then booked an Air Canada flight from Frankfurt to To-

ronto. Finally, we had two flights booked to get us home. The night before we were flying to Frankfurt, we were told our hotel was clos-

ing the next day. We just made it, avoiding being stranded in Majorca. I did not sleep much and kept checking my phone, hoping I 

would not see any cancellation messages. It all worked out as planned!  We realized that the Lufthansa flight to Frankfurt was a 

“rescue” flight. All the other passengers were German. 

 

Hoping to travel in 2021, but maybe not to an island! 

Palma beach in during lockdown 
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BUY AND SELL 
 

 

                                  WANTED! 

 
The Monitor Team is looking for NPC Members who would like to be a “Featured Photographer” in up-
coming editions of The Monitor. We know who has been featured before… so we are looking forward to 
meeting the rest of you! The Club is interested in knowing a little about you, what attracted you to photog-
raphy, what camera you use, what your favourite subjects are to shoot.  We’d also like to see some of your 
photographs. Please contact a member of the Monitor Team to let us know if you are interested. We won’t 
“grill” you, we won’t share your best kept secrets – we are genuinely interested in letting the Club know 
about our members. If we don’t hear from you we might just come after you! Many thanks! 

 

Janet Taylor 
Moira Fenner 
Barbara Husband 
Elisabeth La Fontaine 

Lang Mill  Janet taylor 
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THE LIFE AND WORK OF GEORGIA O’KEEFFE 

BY ELISABETH LA FONTAINE 

In January I wrote about the famous photographer Alfred Steiglitz. I said that I would write in the spring 
about his wife, the famous painter Georgia O’Keeffe, a woman who has influenced and enriched my life as 
I try to emulate her independence and determination. Georgia O’Keeffe was a woman who lived before her 
time. Unconventional, independent, solitary and stubborn, she was a gifted woman with a determination to 
make her own mark in life and in paint. 

Georgia Totto O’Keeffe was born in 1887 in Sun Prairie, Wisconsin, the daughter of a farming family. Ed-
ucation for women was a family tradition. Georgia's own mother, Ida had been educated in the East.  

At the age of 13 Georgia asked the daughter of a farm employee what she was going to do when she grew 
up. She had no idea. Georgia said “I’m going to be a painter” She said later that she had no idea where the 
thought had come from but she knew it was settled in her mind. 

Georgia was educated privately and had five years of art lessons at various schools in Wisconsin and Vir-
ginia. After receiving her high school diploma in 1905 she went to the Art Institute of Chicago for a year 
followed by a year at the Art Student League in New York City. This was an unsettled time for Georgia – 
she was frustrated by the teaching and took various jobs first as a commercial artist, later as a drawing 
teacher.  

She was frustrated with college… "I have things in my head that are not like what anyone has taught 
me...shapes and ideas so near to me...so natural to my way of being and thinking that it hasn't occurred to 
me to put them down..." 
 

Early in 1916, Anita Pollitzer took some of Georgia's drawings to 
Alfred Stieglitz's 291 gallery. He was to exclaim, "At last, a wom-
an on paper!". He told Anita the drawings were the "purest, finest, 
sincerest things that had entered 291 in a long while.", and that he 
would like to show them. Georgia had never talked with Stieg-
litz...although she had high regard for his opinions as a critic. 
Stieglitz exhibited 10 of her drawings. Unfortunately Georgia had 
not been consulted about this before the exhibit and she angrily 
confronted Stieglitz for the first time over the drawings...later 
agreeing to let them hang.  
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Georgia was working in Texas but in June of 1918 she 
returned to New York and Stieglitz...and to a new life that 
would make her into one of the most important artists of 
the century.  

     New York Street 

 

 

My Shanty, Lake George  

Alfred Stieglitz was 54 when Georgia arrived in New York...23 years her senior. They lived together in New 
York for six years, weathering the criticism, shock and gossip that two people living together generated. 
Eventually Stieglitz managed to persuade Georgia to marry him. Summers were spent with Alfred’s large 
family at Lake George in the Adirondack Mountains – sometimes as many as 20 people would sit down for 
meals and Georgia soon got tired of the endless crowds. During the winters they took a suite at the Shelton 
Hotel in New York. Georgia was a prolific painter, although Stieglitz, who managed her business affairs, 
was loathe to sell her work which fetched prices of over $25,000 in the early 20th century.  

By 1928 Georgia had painted all she wanted to of New York and of Lake George and she was struck with 
the wanderlust. Her friend Beck Strand persuaded her to take the train and to go to Taos, New Mexico to-
gether – a trip that would forever change her life. I truly believe that a visit to New Mexico changes the life 
of everyone who visits – it certainly enriched and changed mine. 

By this time Stieglitz had fallen in love with 
Georgia and wanted to pursue a relationship. 
He being in an unhappy marriage, had 
moved out from the family home and into his 
studio.   
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She fell in love with the desert, the hills, 
the colours, the light and the pink and 
yellow and blue skies. The light was so 
pure that colours were distilled in all 
their beauty. The thin, dry air enabled 
her to see farther...and at times could 
see several approaching thunderstorms 
in the distance at once. She affectionate-
ly referred to the land of northern New 
Mexico as "the faraway"...a place of 
stark beauty and infinite space.  

 

  The Faraway Nearby 
 

Soon after their arrival, Georgia and Beck where invited to stay at Mable Dodge Luhan's ranch outside of 
Taos for the summer. She would go on many pack trips exploring the rugged mountains and deserts of the 
region. Among other guests to visit the ranch were, D.H. Lawrence, Charles and Anna Lindbergh, and An-
sel Adams. D.H. Lawrence had a neighbouring ranch and Georgia spent several weeks there.  

 

Ranchos de Taos 
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Being a loner, Georgia wanted to explore this wonderful place on her own. She bought a Model A Ford and 
asked others to teach her how to drive. After one particularly exasperating moment, one of her teachers de-
clared that she was unable to learn the art of driving. Only her determination was to lead to mastering her 
machine. Her machine became her on-site studio where she could turn the seats around and paint inside, 
away from the dust and heat. There were few trees in the desert to provide shade and she always found 
groups of Indians sitting under them in the noonday sun so she would lie under her car – the only other 
shade she could find. 

Ghost Ranch  

 

In 1940 she purchased Ghost Ranch, located in a remote 
area 120 miles north of Albuquerque. She not only 
bought the ranch but also the view of the flat-topped me-
sa in the Hemez range, called the Pedernal. She jokingly 
remarked: "It's my private mountain, It belongs to me. 
God told me if I painted it enough, I could have it."    

 

 

        Deer Skull with Pedernal 
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In 1946, when Georgia was 59, Stieglitz died 
and she moved permanently to New Mexico.  

The drive of some 80 miles to Santa Fe to pur-
chase provisions irked Georgia and so in De-
cember 1945 she bought an abandoned haci-
enda with a large garden where she could 
grow most of her provisions.  

 

In 1962 Georgia was elected to the 50 member Amer-
ican Academy of Arts and Letters, the nation's high-
est honor society for people in the arts. By the 70's 
people began to take renewed interest in her work. 
She was invited to show at the Whitney and her retro-
spective exhibit travelled to the Art Institute of Chica-
go and San Francisco Museum of Art...setting new 
attendance records. Her popularity was skyrocketing.  

 

Jimson Weed 

Calla Lillies  

Red Canna 
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She later dabbled in pottery herself, and had a large kiln installed at the ranch for firing pots. Even with her 
dimming eyesight she was inspired by Hamilton to paint again. She hired a studio assistant to execute some 
of her ideas.  

O'Keeffe's love of Ghost Ranch remained as strong as the first day she had seen it more than 40 years before. 
 

"When I think of death, I only regret that I will not be able to see this beautiful country anymore...unless the 
Indians are right and my spirit will walk here after I'm gone." 

 
Georgia became increasingly frail in her late 90's and moved to Santa Fe where she would die on March 6, 
1986, at the age of 98. She was cremated and Juan Hamilton walked to the top of the Pedernal Mountain and 
lovingly scattered her ashes to the wind...over her beloved "faraway". 

If you would like to read more about Georgia O’Keeffe, I have more than 20 books of her life and her paint-
ings and am willing to lend them – or even sell some! 

In 1971 Georgia became aware that her eyesight 
was failing. At the age of 84, she was losing her 
central vision and only had peripheral sight...an 
irreversible eye degeneration disease. She would 
stop painting in 1972. 

 
Juan Hamilton, a young potter, appeared at Geor-
gia's ranch house one autumn day in 1973 looking 
for work. She hired him for a few odd jobs and 
would employ him full time shortly thereafter. He 
became her closest confident, companion, and 
business manager until her death. "He came just 
the moment I needed him." 

Many thanks to those who volunteer their time and 

talents to the Northumberland Photography Club.  
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PHOTOGRAPHY QUIZ 
BY ELISABETH LA FONTAINE 

 
Test your knowledge of photography and photographers! 

 
 
1. What Are the Elements of the Exposure Triangle? 
a) Aperture – White Balance – Shutter Speed 
b) Shutter Speed – ISO – Camera Mode 
c) Aperture – ISO – Shutter Speed 
d) ISO – White Balance – Flash Power 
 
2. What Were the Most Popular Photography Subjects in the 1800s? 
a) Horses 
b) The deceased 
c) Teacups 
d) Trees 
 
3. Who Photographed the Famous Picture ‘The Afghan Girl’? 
a) Steve McCurry 
b) Cindy Sherman 
c) David LaChapelle 
d) Mario Testino 
 
4. What Does Photography Mean, and in What Language? 
a) Capture the Light in German 
b) Drawing with Light in Greek 
c) Freezing the Light in Italian 
d) Stopping the Light in French 
 
5. Which of These Is NOT a Compositional Guideline in Photography? 
a) Rule of thirds 
b) Golden ratio 
c) Leading lines 
d) Three seconds rule 
 
6. Where Did Kodak Get Their Name From? 
a) They just liked the K sound 
b) The founder’s middle name was Kodak 
c) It means ‘to capture’ in Polish 
d) After a cartoon character 
 
7. When Was the First Colour Photograph Taken? 
a) 1821 
b) 1899 
c) 1861 
d) 1906 
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8. How Much Was Paid for the World’s Most Expensive Photograph? 
a) $4,338,500 
b) $10,000,00 
c) $1,311,200 
d) $25,312,400 
 
9. The Most Viewed Photograph in History is a Windows Computer Wallpaper 
a) True 
b) False 
 
10. What Scale is Used When Measuring the Colour Temperature of the Light? 
a) Fahrenheit 
b) Kelvin 
c) Celsius 
d) Newton 
 
11. What Does HDR Stand For? 
a) High Digital Range 
b) High Developing Range 
c) High Dynamic Range 
d) High Disturbance Range 
 
12. What Camera Brand Did NASA Use (and Leave Behind) to Photograph the First Steps on the 
Moon? 
a) Nikon 
b) Pentax 
c) Hasselblad 
d) Canon 
 
13. What Is Often a Side Effect of Using a Higher ISO Setting? 
a) Colour imbalances 
b) Digital noise 
c) Battery drain 
d) Big green pixels 
 
14. What Is Aperture Measured In? 
a) Spots 
b) Fractions 
c) F-stops 
d) Inches 
 
15. Edwin H. Land invented… 
a) The off-camera flash 
b) The first photo editing software 
c) The negative 
d) The Polaroid Camera 
 
16. What Is Bokeh? 
a) The aesthetic quality of the blur produced in the out-of-focus parts of an image 
b) The amount of noise in a photo 
c) It’s an acronym 
d) A certain part of a tripod 
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17. What Was the Subject of the First Photo Uploaded to Instagram? 
a) A girl on the beach 
b) Breakfast cereal 
c) A dog near a taco stand 
d) A camera body 
 
18.  Who Took a Photograph of John Lennon Only a Few Hours Before His Death? 
a) Andreas Gursky 
b) Annie Leibovitz 
c) Terry Richardson 
d) Helmut Newton 
 
19. Why Did People Never Smile in Old Photographs? 
a) It was considered rude 
b) They had to sit there for hours because of the long exposure 
c) People had bad teeth and didn’t want to show them 
d)  It was forbidden to smile in public 
 
20. The First Aerial Images Were Taken of Which City? 
a) New York 
b) Paris 
c) London 
d) Birmingham 
 
21. When Was Photoshop Invented? 
a) 1992 
b) 1965 
c) 1999 
d) 1987 
 
 
 
ANSWERS ON THE LAST PAGE 
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Patrick’s Tips 
By Patrick Romano 

 

 

As you may have noticed the majority of the tips I pro-
vide in this column are from the Digital Photography 
School (dps).  I find the tips through on line subscrip-
tions and try and find a timely subject matter for the 
tips offered.  This month I am doing something a little 
different.  The first 3 topics are general things all pho-
tographers should take into consideration.   I especially 
like the quotes made by well-known photographers.  
After that dps has provided their top tips of 2020 in 
different subjects.  When opened, each one contains a 
number of different tips on that subject. Just click on 
the picture to open it.  Some I have provided before but 
most have a great variety to check out.  

Take Care, be safe  and have fun, and share your  

images. 

Pat Romano 

Executive: President: Bryan Marjoram,  Vice President: Brendan Flynn, Secretary: Susan 
Dubois,  Program Director: Donna Edmonds, Membership Director: Vacant,  Financial Direc-
tor: Stan Kicak, Technical Director: Jeannie Gane,  Outings Director: Sandra Peters 

Outreach Director: Gerry Atkinson,  Communications Director: Barbara Husband 

Newsletter co-producers:  Moira Fenner,  Barb Husband,  Elisabeth La Fontaine 

Janet Taylor. 

6 Reasons Why Photography Matters  

 

How These 5 Photography Quotes Can Impact Your Photographic Practice By Megan Kennedy 

 

14 Guidelines for Photographers to Live By John McIntire 

 

15 Ways to Find Photography Inspiration in 2021  By: Megan Kennedy 

 

dPS Top Nature and Wildlife Photography Tips of 2020  By Jaymes Dempsey 

 

dPS Top Photography Tips of 2020  By Jaymes Dempsey 

 

The dPS Top Landscape Photography Tips of 2020 By Jaymes Dempsey 

 

dPS Top Portrait Photography Tips of 2020  By Jaymes Dempsey  

https://digital-photography-school.com/6-reasons-why-photography-matters/
https://digital-photography-school.com/inspirational-photography-quotes/
https://digital-photography-school.com/guidelines-for-photographers/
https://digital-photography-school.com/photography-inspiration/
https://digital-photography-school.com/dps-top-nature-and-wildlife-photography-tips-of-2020/
https://digital-photography-school.com/dps-top-photography-tips-of-2020/
https://digital-photography-school.com/the-dps-top-landscape-photography-tips-of-2020/
https://digital-photography-school.com/dps-top-portrait-photography-tips-of-2020/
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THE LAST PAGE 
BY  BARBARA HUSBAND 

The Guardian Oct. 2019 

Being mindful....a cautionary tale. 
 
It was snowing and it looked like a winter wonderland. I was inspired to get my camera and go in search of 
a beautiful landscape shot. I went to a trail that I'm not that familiar with. There was a creek beside the path 
and Mallards were moseying along quite content to watch me as I watched them. There were no footprints 
ahead of me and I felt like I was the only person in the world, totally unaware of the danger lurking ahead of 
me (cue music from Jaws). 
I walked the path while looking at the creek. I took a step on what I thought was ground and broke through 
ice and into water that was about a foot and a half deep. I fell on my left side and felt blistering pain in my 
left shin and I thought oh nooooooooo.....did my camera get wet??  I knew I couldn't stand up so as I tried to 
collect myself on my hands and knees, all of a sudden it sounded like firecrackers were going off and the ice 
started to crack.  I hesitated long enough to feel the urgency and hear more loud cracking and scrambled for-
ward beneath the boughs of a welcoming tree.  Once again trying to keep my camera behind me I crawled 
out from under the tree. I don't even want to think about what I must have looked like during this whole epi-
sode. I say that because all of a sudden I heard a voice from a distance asking me if I was alright. There 
were two women coming along the path. I explained what happened and advised them not to come any clos-
er. I pulled up my pant leg and discovered a huge egg. One of the women suggested I gather snow into a 
snowball and put it on my shin. My coat was wet, my pants were wet, and my left boot was soaked. I was 
not overly keen. Common sense prevailed and I have filed away that bit of first aid information.  
My take-away from this experience was wow, unexpected things can happen very quickly. I didn't have my 
cell phone with me, my car keys were in my left pocket, which was not zipped, and no one knew where I 
had gone.  To add insult to injury...I didn't get a landscape shot.......but my camera stayed dry. 

 ANSWERS TO PHOTOGRAPHY QUIZ  

1 c 2 b 3 a 4 b 

5 d 6 a 7 c 8 a 

9 a 10 b 11 c 12 c 

13 b 14 c 15 d 16 a 

17 c 18 b 19 b 20 b 

21 b             


